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I .   E x p o s u r e P r o ™ 2 . 0

I n t r o d u c t i o n

The Problem...

The screen capture built into the MacOS, while helpful for average users, falls far
short of meeting the needs of graphics professionals and others who require pixel-
by-pixel control of any image plucked from the screen. In addition, since most
screen captures must be imported into a graphics editing program for touch-up, con-
densing, saving as a particular file format, or having instructional concepts spelled
out on them, why not simply implement all changes before actually snapping the
picture? If you have to make several screen captures in a row and edit each of them
a certain way to make a particular point, the extra work of pulling the capture into a graphics application, making the
necessary changes, and saving the file can really turn into a hassle.

The Solution...

Enter ExposurePro™ 2.0. With one simple press of a hot key, the screen is temporarily frozen, and the
ExposurePro™ 2.0 palette is summoned to the screen to make precise, accurate, and easy screen captures which may
be saved in a variety of popular graphic file formats. All of this, in most any application, regardless of which MacOS

computer or monitor or monitors you might be using. Need to grab and blow up
a section of a spreadsheet for quick publishing on your company’s intranet? Just
invoke ExposurePro™ 2.0, use the selection tool to grab the needed area, bump
up the magnification to required level, click to save as a JPEG, and hit GO! to
make the capture. Move that JPEG into a web page and you are ready to share
your ideas with anyone who can access that web page. No additional applica-
tions needed; no more mouse clicks.

But wait, there’s more...

Beyond that, ExposurePro™ 2.0 lets you edit the screen in a variety of
ways while the screen is still in it’s “frozen mode,” the period after bringing the
ExposurePro™ 2.0 palette to the screen. ExposurePro™ 2.0 is a powerful, fully-

featured drawing application, which gives you the unique opportunity to set up the screen exactly as you need it so
that you can capture it and move on. You can add lines, arrows, text, whatever, right on the screen. Draw, erase, paint
or scribble to your heart’s content. If you make a mistake, simply Undo your error, just like any other drawing appli-
cation. Add patterns, stamp a variety of cursors, select precise colors right off the screen with the eyedropper tool,
and make your capture using a lasso tool, all with only a few mouse clicks and without hopping from application to
application.

Need a little closer view of what you are doing for those precise drawing or capturing jobs? Simply bring
the fatbits palette to the screen and give your eyes a rest. It can tell you the exact RGB values of any particular pixel,
your X and Y position on the screen, and let you know the precise width of height of any selection period. This ensures
you grab exactly what you want, at the size you want.

And all of these tools are integrated in a way that simplifies their use. They are designed to work together
and to help you produce winning images every time. ExposurePro™ 2.0 moves images off of your screen and into
your designs, quickly and efficiently. Do what you dream with your MacOS computer and ExposurePro™ 2.0, in less
time and with less effort than ever before.
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Q u i c k  S t a r t

This manual was designed to be comprehensive and easy to use, but with the enormity of the feature set, you don’t
need to know all of the details to get started. This section will give you the down-and-dirty Quick Start that the
“Manual-Aversive” user needs to get a hint of the power behind the ExposurePro™ 2.0 palettes, and allow you to
rush into capturing and editing screen images.

❶ Run the installer on your ExposurePro™ 2.0 disk, which will guide you through the installation.

❷ Scan the ReadMe file placed on your hard drive. It contains brief notes that might not have made it into the man-
ual, plus the occasional last-minute feature. Now you are ready to capture and edit.

❸ Position your screen exactly as you would like
to capture it, in whatever application and with any
set of documents or graphics on the screen. Note
that you can freeze a screen with any combination
of menus visible.

❹ Press the Command-Shift-3 hot key combina-
tion to freeze the screen and bring the
ExposurePro™ 2.0 palette to the front.

Hint: If the palette does not appear,
confirm that ExposurePro™ 2.0 is in
the Control Panels folder. Open the
control panel and try a different hot
key setting. We tend to use an f-key for
single-key simplicity.

➎ Click the Tools icon to bring up the Tools palette if you have anything to add to the screen. If you need a magni-
fication of the screen for extra close work, click the Fatbits
icon to bring up the Fatbits palette. An Edit menu is also
available, complete with all popular quick key combinations,
offering even more editing control.

➏ Use either the Marquee, Lasso, or Object selection tools
to select the proper area of the screen. Hold down the Shift-
key if you need to select multiple areas, making sure to hold
down the Shift-key during each selection process. You can
mix and match, for example: using the Object selection tool
to Shift-select a couple of parts of a menu hierarchy and a
window, then switching to the Marquee tool and Shift-select-
ing a rectangle to add to the selection.



❼ Decide the file format in which you would like to save the screen capture by clicking on the Format: popup menu.

➑ Set any additional options of the screen capture by turning down the Options tab and adjusting those setting
accordingly.

➒ Hit the Go! button or simply press the Return-key to
make the capture.

The resulting screen capture file, if not
saved to the Clipboard, Scrapbook, or sent
to the printer, will be saved by default at the
root level of your computer’s startup drive,
named Exposure, numbered, and with the
proper designating extension for its file type
noted. If you want to save it elsewhere or
customize the filename, turn off “Quick
Capture.”

❿ Go crazy. Scan the features in the rest of this manual. When you think you are familiar with all of the features,
read it more thoroughly, since there is probably even more you have missed!
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T h e  C o n t r o l s

The ExposurePro™ 2.0 Control Panel

While most users will have little reason to even open it up, the ExposurePro™
2.0 Control Panel does offer some settings that might prove useful. You can turn the
Startup Icon on or off or set a time delay in seconds between the pressing of the
user-defined hot keys. Most users will want to set a different hot key combination
(such as an Function key) than the default Command-Shift-3, but naturally, the
choice is yours. Click the Set Hot Key button, press the combination you desire,
and ExposurePro™ 2.0  records your choice.

The Main ExposurePro™ 2.0 Palette

The essence of ExposurePro™ 2.0 is its main palette which appears after the ExposurePro™ 2.0 hot key combi-
nation is pressed. On this palette, one can find the most important options associated with ExposurePro™ 2.0 while
customizing the operating environment to make the screen captures even easier.

There are four icon areas on the main palette:

❶ Selection Icons - Press any one of these and immediately use that icon’s particular selection
method, from a marquee tool to a lasso or even by the particular window or menu bar.

❷ Tool Icons - These bring forward other palettes or an Edit menu to allow you to alter the
screen or more accurately make a selection.

❸ Format Menu - This simply allows you to choose the right file for-
mat with which to save (or even print) the screen capture.

❹ Option Area - Here, you can select a set of options that will do every-
thing from scale the screen capture area to a particular percentage to vary
the bit-depth of the resulting capture, regardless of the kind of monitor you
use.

The Selection icons help you grab the exact area or areas of the screen you want to capture. With any of the
Selection tools, you can use them multiple times on the same screen by holding down the Shift-
key between uses, even with different tools. Holding down the Option-key while selecting an
area subtracts from any areas already selected, allowing you to selectively crop out previous selection areas.
ExposurePro™ 2.0 even includes a “snap” feature to grab a given scroll bar, section of text or icon by holding down
the Command-key while selecting the needed item. The selection area will “snap” to the item perfectly, leaving little
need to edit.



The most simple Selection tool is the Marquee tool, that creates a flowing, dashed, rectangular line around what-
ever area you designate by holding down the mouse button. The Lasso tool allows you to select screen regions by
freehand. If you don’t complete a lassoed section area, the Lasso tool finishes the selection for you. The Window tool
grabs MacOS windows and menu bars precisely on the edge of that window or menu bar, therefore saving you the
work of cropping it yourself.

If you need at little more precise control with your selection areas, ExposurePro™ 2.0 will let you do a variety of
things with the arrow keys after making a selection. To nudge one or more selection areas after making them, just hit
the arrow keys in the direction you want them to go. To expand the area in any given direction, simply hold down the
Command-key while tapping the arrow key in that direction. Or to contract the area, do the same thing but hold down
the Option-key.

The Tool icons are very important if find yourself doing a lot of screen editing before making the capture. The
Drawing Tool icon simply brings up and dismisses the Drawing Tool palette, which will be dis-
cussed at greater length later in the next chapter. The Fatbits Tool icon just summons and clos-
es the Fatbits palette, which we will look at a little later. Clicking the Edit Tool icon, however, produces a menu with
many different drawing and selection tool options which should be looked into at length.

The Edit menu has several special choices on it that can prove extremely useful.
Of course, the standard fare of Undo, Cut, Copy, Select All and Paste is repre-
sented, but several options may be new or operate differently than you might
think. The Clear option blanks out (makes white) whatever area or areas are
selected at the time it is used. Deselect All removes all selection areas while main-
taining whatever changes have been made to the screen area. Rectangularize
takes an oddly shaped lasso selection and makes it a rectangular selection area,
determined by the X and Y extent of the lasso. It also can be used to combine mul-
tiple selection areas into one, big rectangular selection area. Grow enlarges any
selection areas by one pixel in every direction. Shrink simply reverses the Grow
process. If you have made changes to the screen and would like to start from
scratch, select Revert. The screen will be returned to the state at which it was
frozen. Hide Palettes hides all of the ExposurePro™ 2.0 palettes on the screen at
the time until the mouse is clicked, offering an uncluttered view of the screen.
Outline draws a pixel-thin line around the selection area or areas that makes an
excellent border for captures directly due for publication. Invert reverses the
color scheme of any selected areas. Crop acts like the reverse of Clear, blanking
out anything on the screen outside of the selection area. Quit simply exits out of
the ExposurePro™ 2.0 palette, unfreezes the screen, and returns you to your appli-
cation.

The Format popup menu offers you a plethora of file formats to save the screen cap-
tures. Clipboard and Scrapbook are some of the easiest to use, as you can just snap the
screen and just Paste that shot directly into a page-layout, graphic, or word processing
application, or pile up a lot of screen shots in the Scrapbook to be moved into another
application at a later time. PICT files are very familiar to your MacOS computer and can
easily be opened by Simpletext. GIF files have a limited color palette and a relatively
large size, but they are very clear and popular for use on web pages. JPEG files offer mil-
lions of colors, a small file size, and great popularity on the World Wide Web, but they can
be more blurry than other file types. TIFF files are very large compared to the other file
types, but they very accurately reproduce color on a pixel-by-pixel basis. PNG files offer
millions of colors, a good compression scheme, and great clarity but are rarely used.
Saving as a Startup Screen gives you a way to liven up your MacOS boot experience.



Just drop a Startup Screen save into the System Folder, restart your MacOS computer, and enjoy. For Drag and Drop
users, PICT Clippings offer the option to save screen captures as files and then drag them into your documents.
Screen captures sent to the Printer will be printed using the current printer selected in the Chooser.

Note: ExposurePro™ 2.0 captures exactly what is on your screen, so jagged screen images
will be captured faithfully.

The Options menu, accessed by turning down the Options tab, offers six settings which affect the functionality
of ExposurePro™ 2.0. Quick Capture, which is selected by default, allows ExposurePro™ 2.0 to immediately save

screen captures to the startup drive or print them without displaying a dia-
log box. This saves you time by keeping you from having to name each file
right as you make every capture. Stick Around keeps the palette up after a
capture so that you don’t have to refreeze the screen to use ExposurePro™
2.0 again. Scale allows you to proportionally change the size of the screen
capture between 1 and 999 percent when checked. Info Stamp places a

stamp at the bottom of the screen capture, listing the application, date and time of the screen capture. Capture Cursor
allows you to toggle between capturing and not capturing the cursor in a screen shot. Screen Depth permits you to
save screen captures at screen bit-depths greater and smaller than what your monitor can actually display.

Together, these four areas largely determine exactly what shows up in the screen capture and what format is used
to save it.

The Fatbits Palette

If accuracy is extremely important to you in your screen captures, the
Fatbits palette will prove to be a great help. It provides a 16x16 pixel
view around the ExposurePro™ 2.0 cursor, giving you excellent preci-
sion as you set about drawing on an area of the screen or grabbing a par-
ticular area for a screen capture. To the right of the Fatbits palette, the
Red, Green, and Blue readings are displayed for the pixel currently
selected, and the X - Y coordinates let you know exactly where you are
on the screen from its point of origin. If you are concerned about the
exact size of a capture, the Width and Height readings will let you grab
an image of a particular size in pixels.

The Tools Palette

One of the greatest advantages to using ExposurePro™ 2.0 for screen capture over the
built-in system screen capture abilities or another 3rd-party software solution is the presence of
the Tools palette. Each one of the tools, while having a different use for marking up the screen,
can be very useful for quickly conveying ideas to the audience of your screen capture. Using
the Tools palette, the screen becomes your canvas. 

Before we launch into what each tool can do, it is important to understand how to use the
pattern and color selecting tools at the bottom of the palette. By clicking and holding down the
mouse button on the box to the right of the little pencil, you will bring up a menu of patterns.
The pattern selected here is used by the Line Tool. The little thickness menu, directly to the
right, decides the thickness of any lines you draw. The menu of patterns located below the lit-



tle pencil tool designates the pattern to be used for the paint and fill tools.

To the right of the pattern and thickness selectors is the color designator. The box on top picks the foreground
color of your drawings or fills, while the box behind selects the background color. Note that the pattern selected for
the paint and fill tools is shown in
the foreground color square.
Clicking the little arrows between
the color designators causes the
foreground and background col-
ors to swap places. If you would
like to return the default fore-
ground (black) and background
(white) colors, simply click the
little black and white boxes
between the two color designa-
tors. If you would like to change
the color of any lines drawn, use the square directly below the background color designator. Notice that the line pat-
tern is shown there with the color.

While you will probably use the different tools interchangeably, it is helpful to take a closer look at each one first.
All of these tools have modifier keys that allow you to change their function. While these are discussed at length here,
a useful chart for all of the modifiers to all the tools can be found in the next chapter.

Pencil tool - Perhaps the simplest of all the tools, the Pencil tool simply lets you draw a pixel-thin line in any
direction you want. The color of the Pencil tool is determined by the foreground color. Holding down the

Option-key while using the Pencil tool changes it into an Eyedropper (see Eyedropper below). Doing the same with
the Command-key makes the pencil never erase, even when you start drawing in an area composed of the foreground
color. The Shift-key constrains the Pencil to straight lines.

Brush tool - Similar to the pencil but with more options.
The color of brush is, like the Pencil, the selected as a

foreground color. The resulting pattern of the Brush is selected by
the pattern picker below. Clicking and holding down the mouse
button on the Brush tool brings up a menu of different brush
thicknesses and styles. Holding down the Command-key while
using the Brush tool draws in an overlay mode, where white pix-
els of the selected pattern show through while black pixels are
painted over in the current color (this is very cool for blurring
words). If you press the Control-key while using the Brush tool,
it will draw in a transparent paint mode, very similar to the way
AppleGuide® Markers work. The Shift-key constrains the Brush
to straight lines.

Eraser tool - As you might expect, this tool erases the
screen, including any drawings, back to the designated

background color. Like the Brush tool, clicking and holding on
the Eraser tool brings up a slew of eraser sizes and types. Holding
down the Command-key erases with the current fill pattern. The Option-key allows you to revert whatever the Eraser
touches back to the original state of the screen at the time it was frozen. Also, if you select an area or areas using the
Selection tools, double-clicking the Eraser tool on the Tool palette erases those selections. And, unsurprisingly, the



Shift-key constrains the Eraser to straight lines.

Text tool - Perhaps the most versatile of all the tools,
you can use the Text tool to produce a wide variety of

effects. To simply put some text on the screen, select the Text
tool, click the cursor somewhere on the screen and start typ-
ing. The text will appear, set against the background color cur-
rently selected. To finish typing, just click the mouse outside
the text box. For some variety, try clicking on the Text tool on
the Tools palette until the font, style, and size menus appear.

There are a few rules to using the Text tool. First, you cannot mix styles, fonts, and sizes in a particular text block.
Second, while you are facing a flashing cursor, all ExposurePro™ 2.0 palettes are inaccessible (because, if you click
on them, it will finish up the text box you are now typing). Third, to move text to another place on the screen, finish
typing, click outside the text box, and drag the selected text to whatever place you like. The background from the area
behind the text will be preserved.

If you would like to just capture the text and its background, type your text and click outside the text box. The text
area is then selected. Or if you want to select just the text you typed and not the background or anything else, click
outside the text box with the Command-key held down. Control-key clicking outside the text box blends the text with
the foreground color and selects it (very neat).

Fill tool - The Fill tool allows you to fill in any selected area with the foreground color and pattern. Just make
your selection or selections, click on the Fill tool, and click on the selected area. For a shortcut, just make

your selection and double-click the Fill tool on the Tools palette. If you click on the screen with the Fill tool without
anything selected, it will take the area of wherever you clicked and change its color to the color and pattern of the
foreground.

Eyedropper tool - Need to select a particular color from the screen? Use the Eyedropper tool. Just select the
Eyedropper tool and find the pixel with the color you want to designate as the foreground color. Holding down

the Control-key while using the Eyedropper picks up the pen color, and if you hold down the Command-key, you can
easily designate the background color.

Line tool - You can easily link text to a particular part of
your screen captures using the Line tool. Simply select the

Line tool, click an origination point on the screen, drag the mouse
with the button clicked, and set your final point. The resulting line
can be changed any number of ways. For one, if you click and hold
down on the Line tool on the Tool Palette, you can select from a full
choice of many different line styles. If the angle of the arrowhead
of the resulting arrow doesn’t fit your tastes, click the Edit area and
drag the arrowhead corners to their desired shape. To widen the
width of the line, just use the thickness menu described earlier in
this chapter. To draw in straight or diagonal lines only, hold down
the Shift-key while making the line.



Tear-Off tool - Why settle for a boring rectangular screen capture? Did you
buy a MacOS computer to be boring? Jazz up those captures with the Tear-

Off tool. After selecting an area, click on the Tear-Off tool, and click the area where
you want the tear to begin. Tears aren’t limited to simply facing down; click the
Space-bar to turn the tear upside down or to either side. Note, however, that if you
have two or more selected areas, the Tear-Off tool will truncate all of your selections
at the point you use it on the screen. If you must make multiple tears or have multi-
ple sections for capture, do each tear first and then make the next selection while
holding down the Shift-key.

Stamp tool - If you need to add a special cursor to your capture, the eas-
iest way is to use the Stamp tool. Clicking and holding down the mouse

on the Stamp tool gives you choice of fourteen common MacOS cursors. Just
select the one you want and stamp it where you need it. Holding down the
Command-key while you stamp allows the area behind the stamp to shine through
its white spots and gives the stamp the color of the foreground.

Rectangle , Ellipse , and Irregular Polygon tools - It
makes sense to group these together, as they do much
of the same thing, just with different shapes. Selecting
any of these tools and dragging a shape on the screen
creates a geometric figure with the color of the fore-
ground and with a border of the line color. To create a

square using the Rectangle tool, a circle with the Ellipse tool,
or produce 45-degree angles in your Irregular Polygon, simply
hold the Shift-key down while using any of these tools. The
Command-key makes the white parts of the foreground pattern
transparent, therefore giving you a kind of overlay mode. This
can be particularly helpful when you are attempting to produce
a foreground effect over the background of a screen.
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&  M o d i f i e r s

Shift-key Command-keyOption-keyControl-keyTool

Draws straight lines Makes the pencil
never erase

Changes the cursor
into Eyedropper

Paints straight lines Paints in overlay modeChanges the cursor
into Eyedropper

Paints in transparent mode
like AppleGuide® markers

Erases straight lines Erases using the
current fill pattern

Reverts screen using eraser
to point of freeze

Selects just the text and no
background

Blends the text with the fore-
ground color and selects it

Changes the cursor
into Eyedropper

Designates pen color Designates background color

Draws straight lines

Can be used for multiple
rip-off selections

Makes perfect squares or
circles

Allows for an overlay stamp
in the color of the foreground

Makes the white
parts of the foreground

pattern transparent

Notes:  The eraser and fill tools will work in any selected area if that tool is double-clicked while the selection is
made. Also, the tear-off tool will rotate 90 degrees every time the space bar is hit.
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F i n a l  N o t e s

Memory: Due to the difficult things ExposurePro™ 2.0 must due while the screen is in a frozen state, there are
several things to keep in mind while using it. ExposurePro™ 2.0, like any MacOS application, likes to have as
much memory available as possible. The more, the better. ExposurePro™ 2.0 can usually operate in low memory
situations, but the more space you give it to work, the better it can do its job. If there is not enough free memory to
envoke ExposurePro™ 2.0, the system will beep at you when the hot keys are envoked.

Self-Capture: Also, ExposurePro™ 2.0 actually can get screen captures of itself (after all, how else would we
get the pictures for this manual?). Just use the hot keys twice to invoke the ExposurePro™ 2.0 palette over itself.
Beware, though, since ExposurePro™ 2.0 is not designed to do this, and you are greatly increasing your chance of
causing a problem by using this risky non-feature!

System Compatibility: ExposurePro™ 2.0 is optimized to work with MacOS 8.x, and it will work wonderfully
with any Mac that supports Color Quickdraw running System 7.0.1 or above.

Explore! A wealth of features are available in ExposurePro™ 2.0, and combining them can produce impressive
results we couldn’t begin to describe.



LIMITED WARRANTY
The Beale Street Group warrants that, upon delivery, the disk(s) which the software program is distributed will be free from defects in materials and workmanship and that the software will
substantially conform to the specifications established by The Beale Street Group, Incorporated.

The Beale Street Group does not warrant that the software is free from all bugs, errors and omissions. This warranty gives you specific legal rights and you may have other rights, which vary
from state to state.

If any of the software fails to comply with the warranties set above, The Beale Street Group will replace the disk or, at The Beale Street Group’s option, make a reasonable effort to correct
the program error. You must, however, return all copies of the software, along with a copy of your paid invoice, to your place of purchase within ninety (90) days of the date you received the
software. If The Beale Street Group is unable to correct defective disks or program errors, The Beale Street Group will refund all or a fair portion of the price you paid for this package. This
refund will fully satisfy your claims for software or disk failure. Any replacement software will be warranted for the rest of the original 90-day warranty period or for thirty (30) days from the
date you received the replacement, whichever is longer.

Except as specifically set forth above, The Beale Street Group will not be liable for any:

•  Bug, error, omission, defect, deficiency, or non-conformity in any software.
•  Implied warranty of merchantability or fitness if ninety days have passed from the

date you received the software.
•  Claim of infringement.
•  Claim in tort, whether or not arising in whole or in part from The Beale Street

Group’s fault, negligence, strict liability, or product liability.
•  Claim or any indirect, incidental, special, or consequential damages, cover or

loss of data, revenue or use.

Any written or oral information or advice given by The Beale Street Group’s dealers, distributors, agents, or employees will in no way increase the scope of this warranty. Nor may you rely
on any such oral or written communication.

Some states do not allow limitation on how long an implied warranty lasts or exclusion or limitation of incidental or consequential damages; therefore, the limitations set forth in this agreement
may not apply.

GENERAL

The Beale Street Group is free of legal responsibility for maintaining or assisting the user of this software.

This agreement constitutes the entire agreement and supersedes any prior agreement between The Beale Street Group and you concerning the contents of this package. The Beale Street
Group is not bound by a provision of any purchase order, receipt, acceptance, confirmation, correspondence, or otherwise, unless The Beale Street Group specifically agrees to the provision
in writing. This agreement cannot be amended, modified, or waived unless the change is written and signed by an authorized corporate officer.

THE BEALE STREET GROUP, INC. SOFTWARE LICENSE AGREEMENT
Information in this document is subject to change without notice and does not represent a commitment on the part of The Beale Street Group, Inc. The software described in this docu-

ment is furnished under a license agreement or non-disclosure agreement. The software may be used or copied only in accordance with the terms of the agreement. It is against the law to copy
The Beale Street Group’s software on magnetic, optical, or any other medium for any purpose other than those outlined as PERMITTED USES below.

Carefully read the terms and conditions of this license agreement prior to using this package. Use of all or any portion of this package indicates your agreement to the following terms
and conditions. If you do not agree with such terms and conditions, you should promptly return this package before using it to your place of purchase for a refund or exchange.

DEFINITIONS
The following definitions apply to the terms as they appear in this agreement.

•  “Beale Street Group” means “The Beale Street Group, Inc.”
•  “You” and “Yours” refer to any person or entity that acquires or uses this package.
•  “Package” means the software, documentation and other items accompanying this
agreement.
•  “Software” means the computer program contained in this package, together with all codes, techniques, software tools, formats, designs, concepts, methods, and ideas
associated with that computer program. The term also includes all copies of any part of the software, as well as the manual and other printed materials contained in this
package.

PERMITTED USES
The Beale Street Group grants you a non-exclusive license to use this software in this package according to the terms set forth below.

You may:
•  Operate the software on one computer at a time.
•  Make one backup copy of the software, which automatically becomes the property of The Beale Street Group and is subject to this agreement.

PROHIBITED USES

You may not:
•  Make the software available to any person or entity other than your employees, who must use the software as specified above under Permitted Uses. You may,
however, after written notification to The Beale Street Group, transfer all (but no lesser portion) of the software to another person or entity, who in turn will be
subject to this agreement.
•  Modify the software or merge it with another program, except for your personal use on a single computer. Any modified or merged portion of this software is
subject to this agreement.
•  Reverse-engineer, disassemble, decompile, or make any attempt to discover the source code to the software.
•  Translate or create derivative work based on this software.
•  Remove, obscure, or alter any notice of The Beale Street Group, copyright or other proprietary rights related to the software.
•  Sub-license, sell, lend, rent or lease any portion of the software.
•  Copy a portion of the software, except to make a backup copy, as described above under Permitted Uses.
•  Operate the software on more than one computer at a time. (If you plan to operate the software on a network please contact The Beale Street Group to request
a multi-use license.)
•  Transfer the software or any direct product to any person or entity in violation of the United States Export Administration Act.

This software involves valuable proprietary rights of The Beale Street Group, Inc., and others. The Beale Street Group retains title to and ownership of the software and all copyright, trade
secret, trade name, trademark, and other proprietary rights related to the software, regardless of the form that the original or other copies exist in. You may not violate these rights, and you must
take appropriate steps to protect The Beale Street Group’s publishing rights. The Beale Street Group may at any time replace, modify, alter, improve, enhance, or change the software.
Both the license and your right to use the software terminate automatically if you violate any part of this agreement. In the event of termination, you must immediately destroy all copies of the
software or return them to The Beale Street Group.
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